
Earthworm Jim

Technical Troubleshooting

Introduction

Thank you for purchasing Earthworm Jim. This supplemental documentation is designed as a troubleshooting 
guide in the event you experience technical problems while running the program.  The following contains 
technical tips and other information that could not be included in the online Help file.  

Customer Support Bulletins

In an effort to keep you informed of the latest product developments, Activision has created Customer Support 
Bulletins. These files are located on the various online services and contain the latest information about 
Activision products. 

Troubleshooting

The following information is designed to help you resolve any difficulties you may encounter while running the 
program.

Error Messages

"Earthworm Jim must be played using the CD-ROM"

1. The Earthworm Jim CD must be correctly inserted into your CD-ROM drive in order to play the game.
2. If you have a multi-CD-ROM drive system and/or are currently using Flex CD, Quick CD or any other CD 

utility, these programs may be interfering with the game's ability to detect the Earthworm Jim CD-ROM. It is 
recommended that you disable these programs and/or set your default audio CD drive in Windows® 95 to 
that from which you will be playing Earthworm Jim.  To do this, perform the following steps:

a) Open the "Control Panel" folder and double-click on the "Multimedia" icon.
b) Click on the "CD Music" tab.
c) In the "CD-ROM Drive" drop-down menu, select the drive letter that will be the drive from which you will 
play Earthworm Jim.   

"Requires a 486, Pentium or better processor"

1. Earthworm Jim requires a 486/33 or better processor with a minimum of 8 MB of RAM.  Attempting to run 
the program on a lesser machine may result in hardware and performance difficulties.  

2. The game is not compatible with the NextGen chip as it is a 386 chip that emulates a Pentium.  Earthworm 
Jim requires a 486 or better chip in order to run.   

"Cannot find file..."

1. Check to make sure your CD-ROM drive is optimized in Windows® 95. To do this, peform the following 
steps:



a) Open the Windows® 95 "Control Panel" folder and double-click on the "System" icon.
b) Click on the "Performance" tab, then click on the "File System" button.
c) Click on the "CD-ROM" tab.
d) In the "Optimize Access Pattern" drop-down menu, either select the "No Read Ahead" option or the 
access pattern that corresponds with your CD-ROM drive. You may also experiment with the other various 
settings and/or the Supplemental Cache Size option.

"Requires Windows® 95 or Windows NT™ 3.51+"

1. Earthworm Jim requires the Windows® 95 or Windows NT™ 3.51 operating system. The game is not 
compatible with Windows® 3.1 or other operating systems.

"Earthworm Jim must be played in 256 color mode for optimum performance"

See the section entitled "Game Graphics Are Faded Or Strange In Appearance".

"Are you sure you want to give up the current game?"

1. Using the "File" menu to start a new level or changing the level of difficulty in the middle of a    
      game will reset the weapons, continues, energy level, enemies and other collectables to 
      their default settings.  
2. Switching difficulty levels in the middle of a game will result in the start of a new game in the newly selected 

difficulty mode. However, the game will automatically save the last level played in the previous difficulty 
mode. Read the online Help file for more information about switching levels of difficulty.

"Out of memory error" (during Earthworm Jim Desktop Theme installation/uninstallation)

1. There are too many SET commands used by your system. This happens when you have several 
background applications, such as virus checkers, loaded in memory for use. In this situation, it is 
recommended that you edit your AUTOEXEC.BAT and CONFIG.SYS files to load less background 
applications. Consult your Windows® 95 manual for more information on how to edit these files. It is highly 
recommended that you make backup copies of these files before editing them.   

Windows® 95 Troubleshooting

Activision thoroughly tests its games on a variety of systems before they are released, but it is virtually 
impossible to test on all combinations of software and hardware. Many of the problems you may encounter in 
Windows® 95 are caused by device drivers for video cards, sound cards and CD-ROM drives that are not fully 
compatible with the Windows® 95 operating system.  

The following troubleshooting tips are intended to assist you in solving some of the common problems that occur
with the new Windows® 95 operating system. If you continue to experience technical difficulties after trying the 
following solutions, please contact Activision Customer Support.

Brief Pause During Game

You will experience a slight pause during gameplay when a CD audio track ends and restarts. This is attributed 
to how Windows® 95 multi-tasks between open applications and the CD player. You will most likely experience 
this effect while using other applications that use the CD player. Disabling the "CD Music" option in the 
"Properties" box contained in Earthworm Jim will eliminate this effect during the game. 

Autoplay Does Not Function

1.   Make sure the CD is clean and properly placed in the CD-ROM drive.



2.   Your CD-ROM driver may not be optimized for use with Windows® 95. To verify this, perform the 
following steps:

a) Open the Windows® 95 "Control Panel" folder and double-click on the "System" icon.
b) Click on the "Performance" tab.

If any of your hardware drivers are not fully optimized for use with Windows® 95, they will be listed here with
an explanation of the exact problem and suggestions on how to fix it.

3.   Select the "Refresh" option located in the "View" pull-down menu of your main hard drive window. When the 
Earthworm Jim icon appears, double click on it. The Earthworm Jim title screen should appear afterward.

4. The "AutoPlay" feature may be disabled. To verify this, perform the following steps:

a) Open the Windows® 95 "Control Panel" folder and double-click on the "System" icon.
b) Click on the "Device Manager" tab.
c) Click on the plus sign located next to the "CD-ROM" icon.
d) Highlight your CD-ROM drive and click on the "Properties" button.
e) Click on the "Settings" tab.

The "Auto Insert Notification" box should be checked. If it is not, then click on the checkbox to enable the 
"AutoPlay" feature.

Game Freezes Or Crashes

1. Make sure your system is at least a 486/33 with a minimum of 8 MB of RAM. Trying to run the game on a 
lesser machine may result in hardware and performance difficulties.

2. Disable the "Sound Effects" option in the "Sound" page of the "Properties" box contained in Earthworm Jim. 
Particular sounds may cause the game to freeze when played on certain sound cards. If an updated driver 
does not correct this problem, disabling the sound effects may help to decrease the chance of game 
crashes.

3. Do not leave the game sitting idle for extended periods of time as this may cause your system to lock up. If 
you are not playing the game, please exit the program and restart it later when you want to play again.

4. It is recommended that you reboot your system after experiencing a crash. This helps to ensure that you will
not experience any residual effects related to the crash.   

Game Too Slow

1. If your computer has a turbo button, make sure it is set to the highest MHz possible. 
2. Make sure your system is at least a 486/33 with a minimum of 8 MB of RAM and has a 

double-speed CD-ROM drive. Running the game on a lesser machine may result in hardware and 
performance difficulties.

3. Make sure that your display mode is set to 256 colors. Earthworm Jim should be played in 256 color mode 
for best performance. Although the game may be played in higher color modes, you may experience 
slowdown and minor color changes in game graphics. Although it may be time consuming to have to switch 
between higher color modes and 256 color mode, this is what allows for the high rate of speed in the game. 
To switch to 256 color mode, perform the following steps:

a) Make sure you have a 256 color video driver installed for use.
b) Open the Windows® 95 "Control Panel" folder and double-click on the "Display" icon.
c) Click on the "Settings" tab.
d) Select "256 Color" in the "Color Palette" drop-down menu, then click the "OK" button.

Various utilities that eliminate the need to reboot whenever you switch color modes are available on most 
online services.

4. Playing the game in a large-sized or maximized window and/or while your screen resolution is set above 
640x480 may result in screen "tearing", frame dropout and general slowdown. For better performance in this
situation, it is recommended that you select one of the pre-determined window sizes in the "Display" section 



of the "System" page located in the "Properties" box contained in Earthworm Jim and/or set your screen 
resolution in Windows® 95 to 640x480. To do this, perform the following steps:

a) Open the Windows® 95 "Control Panel" folder and double-click on the "Display" icon.
b) Click on the "Settings" tab.
c) Move the slider bar in the "Desktop Area" section until it reads 640x480, then click the "OK" button.

5. If you are playing the game in an odd-sized custom window, this may result in screen"tearing" and general 
slowdown. For better performance in this situation, it is recommended that you
select one of the pre-determined window sizes in the "Display" section of the "System" page located in the 
"Properties" box contained in Earthworm Jim.

6. If you are running the program on a Pentium machine with a speed of less than 90 Mhz and are playing in 
"Full Screen" mode with the "Sync Full to Monitor" option enabled, this may result in slower performance. 
For better performance in this situation, disable the "Sync Full Screen to Monitor" option.

7. Make sure you are not running an excessive amount of background applications. Before running Earthworm 
Jim, close any applications that are not in use. If you still experience 
slowdown, make sure you are not running any programs or utilites, such as System Agent,
that automatically perform functions at given intervals. Applications that perform auto-scans,
auto-defragmentation and the like may result in slower performance during these functions. 

8.  If you frequently multi-task or your system is linked to a network, go to the "System" page in the "Properties"
box contained in Earthworm Jim and set the "Game Priority" option to "Real Time". This will devote 
maximum processing power to the game. Remember that playing the game in Real Time mode may affect 
any applications running in the background. It is recommended that you do not attempt downloading or other
similar functions while playing in this mode.

9. If you are experiencing general slowdown problems, it is recommended that you play the game in "Full 
Screen" mode, which is designed for maximum display combined with maximum performance. The "Full 
Screen" option is not available when running the program in Windows NT™.      

Game Too Fast

1.   There is a rare problem related to Windows® 95 that results in the game running at twice the             
      normal speed. To resolve this situation, reboot your system and restart the game.

Partial Sound Or No Sound

1. Make sure your sound card is 100% Windows® 95 compatible. Using a non-Windows® 95 compatible 
sound card and drivers may result in sound problems.

2. The "Sound Effects" option is not available when running the program in Windows NT™. 
3. Make sure your speakers are plugged in correctly, turned on and the volume is set at an audible level.
4. Open the Windows® 95 "Volume Control" program to verify that none of the various channels are muted or 

set to an inaudible level.  
5. Make sure the "Sound Effects" and/or "CD Music" options are enabled in the "Sound" page of the 

"Properties" box contained in Earthworm Jim.
6.   Your sound drivers for Windows® 95 may require updating. Check the installation and setup parameters of 

your sound card using the "Device Manager" of Windows® 95 to determine if this is the case. To do this, 
perform the following steps:

a) Open the Windows® 95 "Control Panel" folder and double-click on the "System" icon.
b) Click on the "Device Manager" tab.  
c) Click on the plus sign located next to the "Sound", "Video" and "Game Controllers" icon.
d) Highlight your sound card and click on the "Properties" button.

If you purchased your sound card before the release of Windows® 95, you may obtain updated drivers in a 
variety of places. Most hardware retailers have access to the most recent drivers.  Additionally, most sound 
card manufacturers maintain a BBS containing the latest drivers for free downloading. Moreover, drivers are 
available on CompuServe™, America Online™, The Microsoft Network™ and other popular online services.
A list of sound card manufacturers and their Technical Support and BBS numbers is contained at the end of 



this document. Please make every effort to install the latest sound drivers before calling Activision Customer
Support.

Game Graphics Are Faded Or Strange In Appearance

1. Make sure your video card is 100% Windows® 95 compatible. Using a non-Windows® 95 compatible video 
card and drivers may result in display problems. It is known that playing the game using Trident video cards 
occassionally results in minor color changes in game graphics.  It is recommended that you obtain the latest 
Trident video drivers in an effort to avoid this situation. A list of video card manufacturers and their Technical
Support and BBS numbers is contained at the end of this document.

2. Make sure that your display mode is set to 256 colors. Earthworm Jim should be played in 256 color mode 
for best performance. Although the game may be played in higher color modes, you may experience 
slowdown and minor color changes in game graphics. Although it may be time consuming to have to switch 
between higher color modes and 256 color mode, this is what allows for the high rate of speed in the game. 
To switch to 256 color mode, perform the following steps:

a) Make sure you have a 256 color video driver installed for use.
b) Open the Windows® 95 "Control Panel" folder and double-click on the "Display" icon.
c) Click on the "Settings" tab.
d) Select "256 Colors" in the "Color Palette" drop-down menu, then click the "OK" button.

Various utilities that eliminate the need to reboot whenever you switch color modes are available on most 
online services.

3. If you are experiencing problems in seeing all of the "File" pull-down menu on your screen, it is 
recommended that you change the font size in Windows® 95 to a smaller setting. To do this,
perform the following steps:

a) Open the Windows® 95 "Control Panel" folder and double-click on the "Display" icon.
b) Click on the "Appearance" tab.
c) Select the word "Menu" located in the "Item" drop-down menu.
d) Change the font size by clicking on the bottom arrow in the "Size" menu located to the right of the "Item" 
drop-down menu.

If you purchased your video card before the release of Windows® 95, you may obtain updated drivers in a 
variety of places. Most hardware retailers have access to the most recent drivers.  Additionally, most video 
card manufacturers maintain a BBS containing the latest drivers for free downloading. Moreover, drivers are 
available on CompuServe™, America Online™, The Microsoft Network™ and other popular online services.
A list of video card manufacturers and their Technical Support and BBS numbers is contained at the end of 
this document. Please make every effort to install the latest video drivers before calling Activision Customer 
Support.

Keyboard Controls Do Not Work

1. Make sure the "Keyboard" option is enabled in the "Keyboard" page of the "Properties" box contained in 
Earthworm Jim.

2. Make sure all connections between your keyboard and computer are properly connected.
3. Certain key configurations will not allow three simultaneous key presses, which often results in not being 

able to perform certain game actions simultaneously. You will hear a keyboard "tick" from the PC speaker 
when this happens.    

Gamepad Or Joystick Does Not Work

1. Make sure your joystick is properly calibrated in Windows® 95. To do this, perform the following steps:

a) Open the Windows® 95 "Control Panel" folder and double-click on the "Joystick" icon.
b) Select the appropriate settings in the "Current Joystick" and "Joystick Selection" drop-down menus.
c) Calibrate your controller.



2. Although Windows® 95 contains several built-in gamepad and joystick drivers, you may need to obtain a 
Windows® 95 compatible driver from the gamepad or joystick manufacturer. 

3. The "Joystick" option is not available when running the program in Windows NT™.  

Hardware Manufacturers

The following is a list of Technical Support and Customer BBS numbers for system, sound card, video card and 
CD-ROM manufacturers. Activision has made every effort to ensure that these numbers are correct. However, 
you may want to consult the documentation for your PC, video card, sound card or CD-ROM drive for more up-
to-date information about each company.

System Manufacturers

Acer
Technical Support USA  (408) 434-6677
BBS USA  (408) 428-0140

AST Computers
Technical Support USA  (817) 232-9824
BBS USA  (714) 852-1872

Compaq
Technical Support USA  (713) 378-2000
BBS USA  (713) 378-1418

Dell
Technical Support France 1-30-60-6900

Germany  61-03-971-0
Spain 1-32-91080
United Kingdom 344-860-456
Australia 2-930-3355
Finland 0-692-3122
Ireland 61-304091
Poland  644-2525
Sweden  8-590-05-100
Austria 2243-34100-0
Belgium/Luxembourg 2-466-91-99
Netherlands 20-6812666
Canada (416) 758-2100
Japan 3-5420-5353
Mexico 5-228-7800
Norway 67-125711
Singapore 32-08370
Switzerland 22-979-0101

BBS USA  (512) 728-8528

Epson
Technical Support USA  (310) 782-0770
BBS USA  (310) 782-4531

Gateway
Technical Support USA  (605) 232-2191
BBS USA  (605) 232-2109



Hercules Computer Technology Inc.
Technical Support Germany 14-24-910-5

USA  (510) 623-6050
BBS Germany 14-24-089-8

IBM
Technical Support USA  (404) 238-1234
BBS USA  (919) 517-0001

Intel
Technical Support USA  (503) 264-7000
BBS USA  (503) 264-7999

Leading Edge
Technical Support USA  (508) 836-4800
BBS USA  (503) 836-3971

Micronics
Technical Support USA  (510) 651-2323
BBS USA  (510) 651-6837

Packard Bell
Technical Support France 1-40-64-1000

Germany 89-83-703-1
Italy 2-29-52-7444
Spain 1-45-80055
USA  (801) 579-0161

BBS USA  (801) 250-1600

Tandon Computer
Technical Support USA  (805) 582-6119

Tandy
Technical Support United Kingdom 922-434-000

Toshiba
Technical Support USA  (714) 859-4273
BBS USA  (714) 837-4408

Zenith
Technical Support USA  (708) 808-5000
BBS USA  (708) 808-2264

Sound Card Manufacturers

Advanced Gravis
Technical Support France 1-39-73-1534

Germany 99-61-507-7
USA  (206) 881-6945

BBS USA  (206) 883-3211

ATI Technologies Inc.
Technical Support Germany 46-09-077-7

USA  (905) 882-2626
BBS Germany 46-21-020-1 or 46-09-076-6



Aztech Labs
Technical Support Germany 11-69-084-3
BBS Germany 11-69-178-2

Boca Research Inc.
Technical Support USA  (407) 997-7202
BBS USA  (407) 241-1602

Cardinal
Technical Support USA  (717) 293-3124
BBS USA  (717) 293-3074

Creative Labs
Technical Support France 1-39-20-0421

Germany 31-10-283-8
USA  (408) 736-2000

BBS USA  (918) 742-2377

Diamond Computer Systems, Inc.
Technical Support France 42-20-5959

Germany 78-04-023-5
Italy 39-25-16-671
Spain 1-30-41534
USA  (408) 736-2000

BBS USA  (408) 325-7175

Logitech
Technical Support France 34-48-9050

Switzerland 21-869-9851
USA  (510) 795-8100

BBS USA  (510) 795-0408

Media Vision 
Technical Support USA  (510) 770-9905
BBS USA  (510) 770-0968

Microsoft
Technical Support France 1-69-86-1020

Germany 08-93-176-0
Italy 39-22-69-121
Spain 1-80-40000
USA  (206) 637-7096

BBS Belgium 2-735-00-45

Reveal
Technical Support United Kingdom 818-457-400
BBS USA  (818) 713-8188

Roland US
Technical Support Germany 05-26-0009-0

Italy 29-35-81-311
Spain 3-30-81000
USA  (213) 685-5141

Turtle Beach
Technical Support Switzerland 22-347-1181

USA  (717) 843-6916
BBS USA  (717) 767-5934



Video Card Manufacturers

Actix Systems
Technical Support USA  (408) 986-1625
BBS USA  (408) 970-3719

Advanced Integration Research
Technical Support USA  (408) 428-0800
BBS USA  (408) 428-1735

Advanced Micro Technology
Technical Support United Kingdom 256-811-101
BBS USA  (909) 594-5770

Alpha Systems Lab
Technical Support USA  (714) 252-9200
BBS USA  (714) 252-0624 

Altech International
BBS USA  (408) 946-2227

Artist Graphics Company
Technical Support United Kingdom 844-261-313
BBS USA  (612) 631-7664

ATI Technologies
Technical Support Germany 46-09-077-7

USA  (905) 882-2626
BBS Germany 46-21-020-1 ou 46-09-076-6

Atlaz Intl., Limited
Technical Support USA  (516) 239-1854 

Boca Research Inc.
Technical Support USA  (407) 997-7202
BBS USA  (407) 241-1602

Cache Computers, Inc.
Technical Support USA  (510) 226-9922
BBS USA  (510) 226-7486

Cardinal
Technical Support USA  (717) 293-3124
BBS USA  (717) 293-3074

Celerite Graphics, Inc.
Technical Support USA  (510) 226-6390
BBS USA  (510) 226-7851

Cirrus Logic
Technical Support France 1-48-12-2812

Germany 15-24-008-4
Italy 92-61-34-836
USA  (510) 435-8808

BBS USA  (510) 440-9080



Colorgraphic Communication
Technical Support USA  (404) 455-3921
BBS USA  (404) 452-8238

Cornerstone Technology
Technical Support Germany 97-44-154-0
BBS USA  (408) 435-8943

CSS Laboratories, Inc.
Technical Support USA  (714) 852-8161
BBS USA  (714) 852-9231

Diamond Computer Systems, Inc.
Technical Support France 42-20-5959

Germany 78-04-023-5
Italy 39-25-16-671
Spain 1-30-41534
USA   (408) 325-7100

BBS USA  (408) 325-7175

ELSA America, Inc.
Technical Support USA  (408) 565-9669
BBS USA  (408) 565-9630

Focus Information Systems, Inc.
Technical Support USA  (510) 657-4586
BBS USA  (510) 657-9451

Genoa
Technical Support USA  (408) 432-8324
BBS USA  (408) 943-1231

Headland (Video Seven)
BBS USA  415) 656-05030

Hercules Computer Technology Inc.
Technical Support Germany 14-24-910-5

USA  (510) 623-6050
BBS Germany 14-24-089-8

Liberty Electronics U.S.A.
Technical Support USA  (510) 623-6000

Matrox Electronics Systems Limited
Technical Support USA  (514) 685-2630
BBS USA  (514) 685-6008

Metheus Corporation
Technical Support United Kingdom 734-312-112
BBS USA  (503) 690-1559

Micron Computer
Technical Support USA  (208) 463-3444 

MicroStep, Inc.
Technical Support USA  (818) 336-8991
BBS USA  (818) 961-9992



Mirage Computer Systems
Technical Support USA  (310) 301-4541
BBS USA  (310) 301 4542

National Design, Inc.
Technical Support USA  (512) 329-5055
BBS USA  (512) 329-6327

Number Nine Computer Corporation
Technical Support Germany 96-14-491-0
BBS Germany 96-12-139-0

Nth Graphics
Technical Support USA  (512) 832-1944
BBS USA (512) 832-1964

Oak Technology
Technical Support USA  (408) 737-0888
BBS USA  (408) 524-9014

Orchid Technology Inc.
Technical Support France 1-47-80-7050

Germany 13-28-007-1
United Kingdom 256-479-898

BBS United Kingdom 256-463-373

Paradise
BBS USA  (415) 968-1834

Sigma Designs
Technical Support Germany 89-33-644-3
BBS USA  (510) 770-0111

SixGraph Computing, Limited
BBS USA  (514) 336-4169

STB Systems
Technical Support United Kingdom 818-970-662
BBS United Kingdom 818-971-008

SuperMac Technolgy, Inc.
Technical Support USA  (408) 245-0646
BBS USA  (408) 773-4500

Swan Technologies, Inc.
Technical Support USA  (814) 238-1820
BBS USA  (814) 237-6145

Trident Microsystems Inc.
Technical Support USA  (415) 335-1179
BBS USA  (415) 691-1016

Tseng Labs
Technical Support Germany 49-00-004-9

Belgium 2-716-50-00
USA  (215) 968-0502

BBS USA  (215) 579-7536



Video Logic, Inc.
Technical Support United Kingdom 923-260-511
BBS United Kingdom 923-271-301

Video Seven
BBS USA  (510) 656-0503

VidTech Microsystems, Inc.
Technical Support USA  (612) 785-9717
BBS USA  (612) 780-8033

Western Digital
Technical Support USA  (714) 932-4900
BBS USA  (714) 753-1234

Willow
Technical Support USA  (718) 402-0203
BBS USA  (718) 993-2066

CD-ROM Manufacturers

Hitachi
Technical Support France 1-48-21-6015

Germany 40-73-441-0
Italy 39-02-30-231
Spain 3-33-08652

Mitsumi
Technical Support USA  (415) 691-4465

NEC
Technical Support USA  (508) 264-8000
BBS USA  (508) 635-4706

Panasonic
Technical Support France 1-49-46-4300

Germany 32-18-702-0
Spain 7-24-81100

BBS USA  (201) 863-7845

Sony
Technical Support USA  (408) 894-0555
BBS USA  (408) 955-5107

Teac
Technical Support USA  (213) 726-0303
BBS USA  (213) 727-7660


